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I PIRKIMO OBJEKTO DALIS 

„LEIDYBOS IR TIRAŽAVIMO PASLAUGOS MOKSLO PUBLIKACIJOMS, LEIDINIAMS IR ELEKTRONINIAMS LEIDINIAMS“

TECHNINĖ SPECIFIKACIJA

I. BENDROJI DALIS
	Perkančioji organizacija – Vytauto Didžiojo universitetas (K. Donelaičio g. 58, LT-44248 Kaunas) perka leidybos ir tiražavimo paslaugas mokslo publikacijoms, žurnalams, leidiniams ir elektroniniams leidiniams (toliau – paslaugas).
Perkančioji organizacija vykdo žaliąjį pirkimą, todėl, vadovaudamasi Lietuvos Respublikos aplinkos ministro 2011 m. birželio 28 d. įsakymu Nr. D1-508 „Dėl Aplinkos apsaugos kriterijų taikymo, vykdant žaliuosius pirkimus, tvarkos aprašo patvirtinimo“ (aktualia redakcija) 4 p. 4.1. papunkčio, 2 priedo I skyriaus 1 punktu taiko šiuos minimalius leidybos, spausdinimo ir su spausdinimu susijusių paslaugų aplinkos apsaugos kriterijus:
	Eil. Nr.
	Reikalaujami minimalūs aplinkos apsaugos kriterijai leidybos, spausdinimo ir su spausdinimu susijusioms paslaugoms
	Atitiktį reikalavimams įrodantys dokumentai, kuriuos privalo pateikti paslaugų teikėjai
	

	1
	2
	3
	

	1.
	Spaudiniai turi būti spausdinami ant popieriaus, atitinkančio minimalius aplinkos apsaugos kriterijus: gaminys turi būti pagamintas iš 100 proc. perdirbto popieriaus (naudoto popieriaus ir (ar) gamybos atliekų) plaušų arba ne mažiau kaip 30 proc. pirminės medienos plaušų, gautų iš miškų, sertifikuotų naudojant Forest Stewardship Council (toliau – FSC) arba Miškų sertifikavimo sistemų pripažinimo programą (angl. Programme for the Endorsement of Forest Certification schemes (toliau – PEFC), arba lygiavertes miškų sertifikavimo sistemas, kita dalis – iš perdirbto popieriaus plaušų.
	Ekologinis ženklas Blue Angel arba Nordic Swan, arba European Ecolabel, arba FSC ar PEFC sertifikatas, arba paslaugų teikėjo deklaracija, arba kiti lygiaverčiai įrodymai. 
Pateikiamas skenuotas dokumentas elektronine forma. 
	

	2.
	Popierius turi būti nebalintas arba balintas nenaudojant chloro dujų: gamyboje naudojama ECF (Elementary Chlorine-Free) technologija (balinimui nenaudojamos chloro dujos, bet naudojami chloro junginiai) arba TCF (Totally Chlorine-Free) technologija (balinama deguonimi, vandenilio peroksidu ar kitomis chloro junginių neturinčiomis priemonėmis).
	Ekologiniai ženklai Blue Angel arba Nordic Swan, arba gamintojo techniniai dokumentai, arba paskelbtos (notifikuotos) įstaigos bandymų protokolas, arba paslaugų teikėjo deklaracija, arba kiti lygiaverčiai įrodymai. 
Pateikiamas skenuotas dokumentas elektronine forma.
	

	3.
	Technologiniuose procesuose neturi būti naudojami ofsetinių plokščių ryškinimo procesai (pavyzdžiui, naudojama tiesioginė iš kompiuterio į plokštę technologija (angl. Computer to Plate).
	Techniniai dokumentai arba paslaugų teikėjo deklaracija su turimos technologijos aprašymu. 
Pateikiamas skenuotas dokumentas elektronine forma.



Tiekėjo pasiūlymas bus atmetamas, jeigu paslaugų tiekėjas nepateiks nurodytų dokumentų, įrodančių atitiktį minimaliems aplinkos apsaugos kriterijų reikalavimams.

1. Paslaugų teikėjas privalo pateikti elektroninėje erdvėje matomus siūlomos paslaugos pavyzdžius (bent 3), atspindinčius aukštą išleistų leidinių turinio parengimo leidybai sudėtingumą, poligrafinę kokybę.
2. Planuojamos įsigyti paslaugos ir jų kiekiai išvardyti 1, 2 ,3 lentelėse.
3. Paslaugų teikėjas neįgyja teisių į užsakytą išleisti kūrinį – pirminis ISBN, eISBN (tarptautinis standartinis knygos registras) ar kitas galimas kūrinio registracijos numeris registruojamas Perkančiosios organizacijos vardu. Perkančioji organizacija perka leidinių parengimą (DOC, INDD, IDML, PDF, ePUB) formatais (kiekvienas leidinys turi būti parengtas visais užsakyme prašomais formatais). Paslaugų teikėjas, išleidęs leidinį, nedelsdamas perduoda Perkančiajai organizacijai išsaugotus (DOC, INDD, IDML, PDF, ePUB) jo formatus. 
4. Už paslaugas Perkančioji organizacija atsiskaito pagal Paslaugų teikėjo pasiūlytus leidybos ir tiražavimo paslaugų mokslo publikacijoms, žurnalams, leidiniams ir elektroniniams leidiniams pirkimo įkainius.
5. Perkančiajai organizacijai turi būti sudaryta galimybė operatyviai derinti tarpinį paslaugų atlikimo rezultatą ir esant reikalui daryti atitinkamus pakeitimus. Atliktų paslaugų tarpiniai rezultatai privalo būti dedami į paslaugų Teikėjo interneto serverio Perkančiajai organizacijai priskirtą sritį, ir tokiu būdu derinama iki teigiamo galutinio rezultato nepažeidžiant paslaugų atlikimo terminų. 
6. Paslaugų teikimo terminas – 12 mėnesių su galimybe pratęsti 2 kartus po 12 mėnesių. 
7. Parengti publikavimui elektroniniai leidiniai nedelsiant turi būti perduoti Perkančiajai organizacijai elektroninėmis ryšio priemonėmis ir (arba) įkelti į Teikėjo interneto serverio Perkančiajai organizacijai priskirtą sritį. Atspausdinti leidinių tiražai turi būti supakuoti ir iš anksto sutartu laiku privalo būti pristatyti Paslaugų teikėjo transportu į Perkančiosios organizacijos nurodytą vietą – VDU Valdymo ir investicijų departamento Leidybos centrą, Studentų g. 11-154, Akademija, Kauno r., ar į kitą VDU padalinį Kaune.

II. PUBLIKACIJŲ, LEIDINIŲ IR ELEKTRONINIŲ LEIDINIŲ LEIDYBOS PASLAUGŲ SPECIALIEJI REIKALAVIMAI

8. Kiekvienam leidybos paslaugų pirkimo užsakymui atskirai suderinama perkamų paslaugų sąmata, įvertinta Paslaugų teikėjo pasiūlytais leidybos ir tiražavimo paslaugų mokslo publikacijoms, žurnalams, leidiniams ir elektroniniams leidiniams pirkimo įkainiais.
9. Publikacijų, leidinių ir elektroninių leidinių tekstai vertimui, redagavimui bus perduodami pranešus iš anksto (prieš 2 darbo dienas). 
10. Leidinių maketams keliami papildomi reikalavimai, siekiant užtikrinti galimybę iš jų toliau rengti prieinamumo reikalavimus atitinkančius sertifikuotus ePUB3 formato leidinius, makete privalo būti įdiegta sisteminė semantinė struktūra (ne tik vizualus formatavimas):
10.1. visi tekstai formatuojami naudojant pastraipų stilius (Paragraph Styles) ir simbolių stilius (Character Styles); tiesioginis formatavimas (manual override) nenaudojamas;
10.2. antraštėms parengti atskiri stiliai pagal hierarchiją (Antraštė 1, Antraštė 2, Antraštė 3 ir t. t.) be praleidimų; kiekvienam pastraipos stiliui per Export Tagging skiltį priskiriamas atitinkantis HTML žymėjimas (h1, h2, h3, p, blockquote ir kt.);
10.3. sąrašai (numeruoti, ženklinti) parengti tik naudojant InDesign sąrašų funkciją (Bulleted/Numbered Lists), o ne įvedant simbolius rankiniu būdu;
10.4. lentelės parengtos kaip InDesign lentelės (Table) su pažymėta antraštės eilute (Header Row), o ne paveikslėliais ar tekstiniais blokais; sudėtingoms lentelėms suformuoti naudojami antraščių susiejimo (scope/headers) atributai;
10.5. citatos formatuojamos atskiru stiliumi su Export Tagging: blockquote; 
10.6. išnašos pridedamos tik per InDesign išnašų funkciją (Type → Insert Footnote), o ne rankiniu būdu;
10.7. naudojama Articles paletė nustatant tikslingą skaitymo seką – kiekvienas skyrius pridedamas kaip atskiras Article; tekstiniai laukai sujungiami grandinine seka (text threads);
10.8. iliustracijos (paveikslai, fotografijos, schemos, grafikai) įdedamos kaip Anchored Objects (susietos su tekstu, ne „plūduriuojančios“ puslapyje); kiekvienam vaizdui per Object Export Options skiltį suteikiamas alternatyvusis tekstas (Alt Text) lietuvių kalba arba pažymima, kad vaizdas yra dekoratyvinis (Artifact);
10.9. matematinės ir cheminės formulės įdedamos tik kaip redaguojamas turinys (per InMath, MathTools ar lygiavertį įskiepį), išsaugant MathML šaltinį, o ne kaip paveikslėliai;
10.10. hipersaitai parengiami per InDesign Hyperlinks paletę (Window → Interactive → Hyperlinks); URL'ai neįvedami tiesiog tekstu;
10.11. puslapių numeracija nustatoma automatiškai tik per InDesign puslapių sistemą (o ne įrašoma rankiniu būdu); turinys (Table of Contents) sugeneruojamas per Layout → Table of Contents funkciją;
10.12. dokumento kalba nustatoma į „Lithuanian“ (Character → Language); kitomis kalbomis rašomi fragmentai pažymimi atitinkamos kalbos atributu;
10.13. spalvų kontrastas tarp teksto ir fono ne mažesnis kaip 4,5:1 (normaliam tekstui) ir 3:1 (didelio dydžio tekstui, ne mažesniam kaip 18 pt arba 14 pt bold); reikšminė informacija perduodama ne tik spalva;
10.14. naudojami tik OpenType arba TrueType šriftai (o ne Type 1);
10.15. užpildomi dokumento metaduomenys (File → File Info): pavadinimas, autoriai, aprašymas (anotacija), raktažodžiai, autorių teisės, dokumento pavadinimas (Document Title);
11. Vieno autorinio lanko (40 tūkst. spaudos ženklų įskaitant tarpus) teksto vertimo, redagavimo ir korektūros darbams atlikti skiriama ne daugiau kaip: 
11.1. vieno autorinio lanko teksto vertimui – ne daugiau kaip penkios (5) darbo dienos;
11.2. vieno autorinio lanko teksto redagavimui ir korektūrai – ne daugiu kaip trys (3) darbo dienos;
11.3. leidinio stiliaus, viršelio ir titulinio puslapio sukūrimui bei maketavimui, parengiant elektroninę versiją su aktyviu turiniu (bookmarks) ir aktyviomis nuorodomis – ne daugiau 15 darbo dienų. 
Publikacijos, leidinio ar el. leidinio signalinis egzempliorius parašui / vertinimui Perkančiajai organizacijai turi būti pateiktas ne vėliau kaip po: (verčiamo kūrinio autorinių lankų skaičius x 5 d. dienos) + (redaguojamo ir koreguojamo kūrinio autorinių lankų skaičius x 3 d. dienos) + 15 d. dienų kūrinio stiliaus ir viršelio sukūrimui, maketavimui (įvertinant ir 10 punkte maketams keliamus papildomus reikalavimus), maketo korektūrai, parengimui spaudai ir publikavimui (pateikti visais užsakyme prašomais DOC, INDD, IDML, PDF, ePUB formatais).
12. Nespalvotos spaudos leidiniams su minkštu ar minkštu su atvartais spalvotu laminuotu viršeliu atspausdinti, susiūti lankus, įrišti ir pristatyti Perkančiajai organizacijai skiriama ne daugiau kaip 5 darbo dienos nepriklausomai nuo tiražo.
13. Spalvotos spaudos leidiniams su minkštu, minkštu su atvartais spalvotu ar kietu viršeliu ir nespalvotos spaudos leidiniams su kietu viršeliu atspausdinti, susiūti lankus, įrišti ir pristatyti Perkančiajai organizacijai skiriama ne daugiau kaip 5 darbo dienos nepriklausomai nuo tiražo.
14. Vieną autorinį lanką sudaro 40 000 spaudos ženklų, įskaitant tarpus tarp žodžių arba 3 000 cm2 spausdinto ploto iliustracijų.
15. Parengti elektroniniai leidinių maketai (INDD, IDML, PDF formatais) prieinamumo reikalavimus atitinkančiam ePUB3 formatui gaminti bus peržiūrimi už šių leidinių leidybą atsakingų darbuotojų. Su kiekvienu užsakymu Perkančioji organizacija nurodys atsakingų asmenų kontaktus.
16. Parengti publikavimui (su aktyviu turiniu (bookmarks) ir aktyviomis nuorodomis) ir (ar) tiražavimui skaitmeniniai mokslo leidinių signaliniai egzemplioriai bus peržiūrimi už mokslo leidinių leidybą atsakingų darbuotojų. Su kiekvienu užsakymu Perkančioji organizacija nurodys atsakingų asmenų kontaktus.
17. Tarpinis perkamų paslaugų derinimas turi baigtis leidinio viršelio ir vidaus lankų signalinio egzemplioriaus pasirašymu spaudai. Perkančioji organizacija, peržiūrėjusi spaudai, publikavimui ir prieinamumo reikalavimus atitinkančio ePUB3 formato leidinio gamybai parengtus maketus, pasirašo juos raštu ar patvirtina momentinio ryšio priemonėmis.
18. Spaudai naudojamas „žaliąjį“ pirkimą atitinkantis popierius, Paslaugų teikėjo pasiūlytas ne mažiau kaip iš 10 popieriaus rūšių ir suderintas su Perkančiąja organizacija:
18.1. [bookmark: OLE_LINK8][bookmark: OLE_LINK9]nespalvotos spaudos leidinių vidaus lankams naudojamas 80–100 g/m² ofsetinis, knyginis ar panašus popierius; 
18.2. spalvotiems leidiniams – žurnalinis, kreidinis ar panašus aukštos kokybės ne mažiau kaip 90 g/m² popierius; 
18.3. minkštiems leidinių viršeliams naudojamas ne mažiau kaip 300 g/m² dvipusio kreidavimo knygų viršeliams skirtas popierius;
18.4. kieto įrišimo knygų viršelių gamybai naudojamas ne mažiau kaip 2–2,5 mm knyginis kartonas;
18.5. kieto įrišimo knygų priešlapiams naudojamas ne mažiau kaip 140–170 g popierius;
18.6. kieto įrišimo knygų viršelių spaudai naudojamas ne mažiau kaip 150 g/m² kreidinis popierius;
18.7. kieto įrišimo knygų viršeliams aptraukti vietoj 19.6 punkte numatyto popieriaus gali būti naudojama: 
18.7.1. drobelė ar tekstilės audinys (Buckram);
18.7.2. specializuotas aukštos kokybės popierius Geltex ar Surbalin; 
18.7.3. vinilinė danga su popieriniu pagrindu Baladekas.
19. Leidinių vidaus lankų spauda gali būti dvipusė nespalvota 1+1 arba dvipusė spalvota 4+4.
20. Leidinių vidaus lankų apimtis gali būti nuo 1 iki 40 spaudos lankų.
21. Galimos papildomos leidinių apdorojimo operacijos, suteikiančios leidiniui išskirtinę išvaizdą ir poligrafinę kokybę: folijavimas, iškirtimas, įspaudai (kongrevas), lakavimas ar dalinis lakavimas UV laku. 
22. Galimi išskirtiniai kieto įrišimo knygos priešlapiai: spalvoto popieriaus, audinio, šilko ar panašios kieto įrišimo knygų priešlapiams skirtos medžiagos. 
23. Planuojami pirkti aukščiau išvardytų paslaugų ir medžiagų kiekiai pateikti 3 lentelėje.
24. Leidiniuose planuojamas preliminarus iliustracijų skaičius ir tipas – nuo 5 iki 50 % leidinių apimties gali būti iliustruota paveikslais, lentelėmis, grafikais ar formulėmis.
25. Visą sutarties galiojimo laikotarpį publikacijos, leidiniai ir elektroniniai leidiniai rengiami, leidžiami ir spausdinami pagal poreikį: nuo 30 iki 1350 egzempliorių tiražais ir (ar) aktyviu turiniu bei nuorodomis elektroninės jų versijos.
26. 1 lentelėje pateikti preliminarūs planuojamų įsigyti mokslo publikacijų, žurnalų, leidinių ir elektroninių leidinių leidybos ir elektroninės leidybos paslaugų kiekiai; 2 lentelėje pateiktos preliminarios tiražavimo paslaugų apimtys ir formatai; ir 3 lentelėje pateikti preliminarūs papildomų poligrafinių paslaugų kiekiai (įvertinus, kad sutartis gali būti pratęsta du kartus po dvylika mėnesių ir galima ±20% paklaida):

	1 lentelė. Leidybos ir elektroninės leidybos paslaugos ir jų kiekiai 

	Paslaugos pavadinimas
	Mato vienetas
	Paslaugų kiekis

	1
	2
	3

	ISBN, eISBN registrai
	vnt.
	150

	Natų suvedimas iš rankraščio
	eilutė
	100

	Partitūros suvedimas iš rankraščio
	eilutė
	100

	Natų redagavimas
	psl.
	100

	Partitūros redagavimas
	psl.
	100

	Teksto lietuvių kalba vertimas į anglų, vokiečių, prancūzų kalbas
	aut. lankas
	50

	Teksto vertimas iš anglų, vokiečių, prancūzų kalbų į lietuvių kalbą
	aut. lankas
	50

	Teksto redagavimas užsienio kalba (anglų, vokiečių, prancūzų)
	aut. lankas
	250

	Teksto korektūra užsienio kalba (anglų, vokiečių, prancūzų)
	aut. lankas
	250

	Teksto redagavimas lietuvių kalba
	aut. lankas
	1000

	Teksto korektūra lietuvių kalba
	aut. lankas
	1000

	Matematikos, chemijos formulių redagavimas
	vnt.
	50

	Matematikos, chemijos formulių korektūra
	vnt.
	50

	Iliustracijų retušavimas, vienodinimas, adaptavimas, rengimas skaitmenine forma 
	vnt.
	3000

	Žemėlapių, vietovių planų su aktualiomis nuorodomis ir intarpais retušavimas, adaptavimas, rengimas skaitmenine forma
	vnt.
	20

	Originalaus leidinio viršelio sukūrimas (kiekvienam pateikti bent po 3 (tris) pasiūlymus)
	vnt.
	70

	Originalaus leidinio stiliaus ir titulinių puslapių sukūrimas (kiekvienam pateikti bent po 3 (tris) pasiūlymus)
	aut. lankas
	300

	Leidinio maketavimas (nesudėtingas tekstas, ne daugiau kaip 10 iliustracijų)
	aut. lankas
	50

	Leidinio maketavimas (sudėtingas tekstas, gausiai iliustruotas arba daug matematikos ir/ar chemijos formulių, lentelių, grafikų ir pan.)
	aut. lankas
	1200

	Leidinio maketo korektūra
	aut. lankas
	1250

	Asmenvardžių, vietovardžių, dalykinių rodyklių sudarymas su nuorodomis į puslapius
	100 įr.
	180

	Terminų žodynų sudarymas
	aut. lankas
	10

	Originalaus dizaino sukūrimas leidinių viršelių įspaudams (kongrevui), folijavimui, daliniam lakavimui UV laku
	vnt.
	10

	Leidinio rengimas .ePUB formatu
	aut. lankas
	50



	2 lentelė. Tiražavimo paslaugų apimtys ir formatai 

	Leidinių (užsakymų) kiekis
	Formatas
	Bendras tiražas
	Vidutinis leidinio spaudos lankų skaičius B2 formate
	B2 talpina nurodyto formato spaudos lankų skaičių

	1
	2
	3
	4
	5

	77
	A5
	7000
	10
	16

	1
	A5
	1350
	4
	16

	95
	B5
	10090
	10
	16

	42
	A4
	4120
	10
	8



	3 lentelė. Papildomos poligrafinės paslaugos ir jų kiekiai 

	Papildomos poligrafinės paslaugos pavadinimas
	Mato vienetas
	Paslaugų kiekis

	1
	2
	3

	Viršelių laminavimas matiniu ar blizgiu laminatu
	vnt.
	20 000

	Viršelių laminavimas soft-touch laminatu
	vnt.
	2560

	Spaudos lankų siuvimas
	vnt.
	171 000

	Segimas sąsiuviniu
	vnt.
	6900 

	A5 formato knygos kieto viršelio aptraukimas drobele ar tekstilės audiniu (Buckram)
	vnt.
	300

	B5 formato knygos kieto viršelio aptraukimas drobele ar tekstilės audiniu (Buckram)
	vnt.
	800

	A4 formato knygos kieto viršelio aptraukimas drobele ar tekstilės audiniu (Buckram)
	vnt.
	800

	A5 knygos kieto viršelio aptraukimas specializuotu aukštos kokybės popieriumi Geltex ar Surbalin
	vnt.
	300

	B5 knygos kieto viršelio aptraukimas specializuotu aukštos kokybės popieriumi Geltex ar Surbalin
	vnt.
	1200

	B5 (17×24) formato knygos kieto viršelio aptraukimas viniline danga su popieriniu pagrindu (baladeku)
	vnt.
	600

	A4 formato knygos kieto viršelio aptraukimas viniline danga su popieriniu pagrindu (baladeku)
	vnt.
	350 

	A5 formato vienpusio spalvoto (4+0) viršelio dalinis folijavimas
	100 cm²
	1200

	B5 (17×24) formato vienpusio spalvoto (4+0) viršelio dalinis folijavimas
	100 cm²
	1200

	A5 formato vienpusio spalvoto (4+0) viršelio dalinis iškirtimas
	100 cm²
	600

	B5 (17×24) formato vienpusio spalvoto (4+0) viršelio dalinis iškirtimas
	100 cm²
	600

	Klišės iki 100 cm² gamyba ir viršelio iškilioji spauda (kongrevas)
	100 cm²
	1200

	A5 formato vienpusio spalvoto (4+0) viršelio dalinis UV lakavimas
	100 cm²
	600

	B5 (17×24) formato vienpusio spalvoto (4+0) viršelio dalinis UV lakavimas
	100 cm²
	600

	A4 formato vienpusio spalvoto (4+0) viršelio dalinis UV lakavimas
	100 cm²
	600

	Priešlapiai kieto įrišimo knygai: spalvoto popieriaus, audinio, šilko ar panašios kieto įrišimo knygos priešlapiams skirtos išskirtinės medžiagos, kai planuojami iki 5 pavadinimų leidiniai po 200 vienetų tiražu
	A5 formatas
	1000

	Priešlapiai kieto įrišimo knygai: spalvoto popieriaus, audinio, šilko ar panašios kieto įrišimo knygos priešlapiams skirtos išskirtinės medžiagos, kai planuojamas iki 4 pavadinimų leidiniai po 250 vienetų tiražu
	B5 (17x24) formatas
	1000

	Priešlapiai kieto įrišimo knygai: spalvoto popieriaus, audinio, šilko ar panašios kieto įrišimo knygos priešlapiams skirtos išskirtinės medžiagos, kai planuojamas 1 pavadinimo leidinys 200 vienetų tiražu
	A4 formatas
	200
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